Toon Boom Harmony 12.0 Release Notes

What's New
Toon Boom Harmony 12.2.1 Release Notes
Version 12.2.1

Here are the new features and bug fixes in Toon Boom Harmony 12.2.1:

Features
Feature

Description

Support for Japanese and Chinese

The Getting Started Guide and menus in Harmony are now available in both Japanese
and Chinese.

Inverted channel version for DPX
export file format

There is an inverted channel version for the export file format DPX 16 bits, as well as 10
and 12 bits.

What's Fixed?
Item Fixed

Description

Fixed crash

Fixed crash when you had two Camera views, one in OpenGL and one in soft render,
and you tried to move an element of the scene.
Fixed importing scenes from database in Manager application.

Fixed issues

Fixed issue where you could not open the queue or send to batch render from previous
versions on a 12.2 database.
Fixed export package created from 12.2 Control Center that could not be reimported in a
different database.
Fixed scripting interface so you can add FBX elements.

Toon Boom Harmony 12.2 Release Notes
Version 12.2

Here are the new features, changes, improvements, and bug fixes in Toon Boom Harmony 12.2:
•

Features on page 1

•

Changes and Improvements on page 2

•

What's Fixed? on page 5

Features
Feature

Description
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Xsheet View

The Xsheet view was added to Harmony Essentials.
Exchange Manager
•

New option to delete exported files after you download them.

•

New Refresh List button lets you update the list of scenes.

•

Exported packages now have informational tooltips that display the dates and full
names of the exported packages.

Advanced Options When Exporting Offline
You can choose to export external drawings, environment or job palettes and libraries.
Checking In and Checking Out Scenes
New Checkin and Checkout commands let you lock or unlock scenes when you
download them or upload them when your work is complete. Locked or checked out
scenes can only be accessed in read-only mode on the database—see Checking
Scenes In and Out on page 1.
Partial Scene Updates between the Database Scene and Its Offline Version

Web Control Center

Web Control Center allows you to update a database scene with only the changes you
made to the same scene on your local computer, and vice versa. If there were changes
to the database scene, you can download them to its offline version on your local
computer. Web Control Center works in tandem with Harmony to make the upload,
download and updating of scenes seamless and quick.
When uploading or downloading a scene, Harmony prepares the export package with
only the changes in the scene, zips it, sends it over the Internet, unzips it and finally
imports it. This is done directly in Harmony Premium or Harmony Advanced; there is no
need to do this in the Web Control Center—see Partial Scene Updates on page 1.
Assigning Users to Scenes
You can assign a user to a specific scene for easier production management—see
Assigning Users to a Scene on page 1.
Customizing Scene Statuses with Different Colours
Create scene statuses with different colours to help differentiate them. You can add
new scene statuses and customize their name and colour, as well as manually edit the
list—see Customizing the Scene Status Colour on page 1.
Advanced Scene Search Options
Search scenes by user or state, or both at the same time—see Searching Scenes on
page 1.

Changes and Improvements
Changes and Improvements

Description
Exporting to Sprite Sheets

Unity Pipeline

Before you can access the new functionalities when exporting to a sprite sheet, you
must replace the TB_CompositionBuilder.js and TB_ExportToSpriteSheets.js scripts
with the most current ones found here:
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Windows: C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony
[version] [edition] \resources\samples\scripts
Mac: /Applications/Toon Boom Harmony [version]
[edition]/tba/resources/samples/scripts
Linux: /usr/local/ToonBoomAnimation/harmony[edition]/resources/samples/scripts
For more information, see
New Options in Unity
•

Ability to move pieces of the character (props of the character), as well as
interactively reorder props in the hierarchy.

•

Unity interface now displays the exported Metadata assets in the Hierarchy tab.

•

Ability to toggle visibility of any layer in Unity from the Inspector tab.

•

Animation scripting interface now allows you to play animation in reverse.

Game Toolbar
The new Game toolbar allows you to create anchors and props, as well as export to
sprite sheets and Easel JS—see How display the Game toolbar on page 1.
Metadata Editor
The new Metadata Editor view lets you access anchor and props options and manage
them—see Metadata Editor View on page 1.
New Export to Sprite Sheets Options
Three new options were added to the Export to Sprite Sheet window:
•

Overwrite Project: Overwrites a previously exported project, including sprite
sheet information and all Unity data. This does not affect the Harmony file in any
way.

•

Clear Texture Folder: Remove any information from the texture folder within
the Harmony file. This does not affect the Unity export but contributes to a lighter
Harmony file.

•

Unit Scale: You can change the Unit Scale when exporting to Unity to
accommodate the size of the export without it affecting the Harmony scene. This
helps you resize assets properly for Unity without having to resize them in
Harmony. The basic scale is one Animation Field for one Unity unit.

For more information, see Export to Sprite Sheets on page 1.
Unicode Support for Environment, Job, Scene and Element Names
Names of Environments, Jobs and Scenes can contain up to 120 ASCII characters.
This means you can use characters for languages, such as Japanese, Chinese, French,
Spanish, and others, characters for names in your database setup.
Database

To enable this feature, select the Allow Unicode Names option in the Preferences
dialog box, Advanced tab. This new option is also available from the Admin menu in the
Control Center. For more information:
Windows: Unicode Guidelines on page 1
Mac: Unicode Guidelines on page 1
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Linux: Unicode Guidelines on page 1
Flexible Scene Data Placement
The /USADATA and /USA_DB directories no longer need to be placed at the root of
your file system. This is useful when using third-party asset management and tracking
systems.
If you choose to place the directories at a location other than the root, you can create a
file that points to the new location of the file system. For more information:
Windows: Flexible Scene Data Placement on page 1
Mac: Flexible Scene Data Placement on page 1
Linux: Flexible Scene Data Placement on page 1
Change of Dictionaries
If you have an existing database, you must replace all the /USA_DB/dicts/ with the new
ones from <application installation path>/etc/USADB_templates/dicts/—see .
Stage Application Renamed
The Stage application is now called Harmony Premium, Harmony Advanced and
Harmony Essentials.
3D Path Keyframes
Miscellaneous

3D Path keyframes can now be gesturally dragged horizontally (in time) in the function
views.
Scrubbing Added to Function Editor View
You can now scrub in the Function Editor view.
General Tab
•

The Minimum FOV and Maximum FOV options were removed.

•

New option for Web Control Center host name and host port in Harmony
Advanced and Harmony Premium Stand Alone.

Drawing Tab
Preferences Dialog Box

New options for defining the default canvas for bitmap layers (resolution, canvas width,
canvas height). You can set the default value for the canvas used by bitmap layers in
new scenes. This prevents users from creating unusually large bitmap canvases. You
can set the resolution and the maximum canvas width and height.
Advanced Tab
New option called Allow Unicode Names lets you use up to 120 ASCII characters for
names of environments, jobs and scenes. You can use characters for languages, such
as Japanese, Chinese, French, Spanish, and others, characters for names in your
database setup.
There are two new options in the File menu of Harmony Premium and Harmony
Advanced Stand Alone for working with scenes on a database:

File Menu

•

New option called Update Database Scene lets you update your database with
only the changes you made to the offline scene. To do this, you must enter your
host name and host port in the Preferences dialog box, General tab.
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•

New option called Download Database Changes. If any changes were made to
the scene you downloaded, you can perform an update by downloading these
changes, which will be seamlessly integrated into your offline scene.

For more information, see Partial Scene Updates on page 1.
Import 3D Models Dialog Box

New option to convert a 3D model file into an OSB which supports internal texture files.

What's Fixed?
Item Fixed

Description
Fixed Harmony crash when calling recursively the evaluation of an expression column.

Crashes

Fixed crash when using very small values in the Blur Radial Zoom effect.
Fixed crash when doing a Reset All on Composite nodes.

Unity 4

Import

Fixed compatibility issues with Unity 4.
Fixed an issue where you could not reimport a scene in a new job if you deleted a job
with the exact same name before.
Fixed the Create Symbol for Imported Items option in the Import Images dialog box as it
would not import anything.
Fixed the Unpaint tool as it could not unpaint a vector drawing made with vector texture
preset. When unpainting, the colour would change to a default red.
Fixed an issue where a drawing with deformation nodes affecting it did not display in the
OpenGL view but appeared in the final render. This can happen when you flip the image.

Drawing

Fixed an issue where a Toon Boom bitmap drawing deformed by a deformation node
does not update in the OpenGL view after a change done with the Select tool.
Removed deprecated drawing versioning option from the Edit Paste Presets dialog box.
The Apply to Visible Drawings option can now be activated and paints only layers that
are the same type (vector or bitmap).
Fixed sharp aliasing when using the Turbulence effect. The resulting images are now
smoother.

Effects
Fixed the Normal Map effect to display all the Volume Objects available. In some
situations, you could not see some of them in the list.
Fixed the Always Create Drawing Files option in the Paste Special dialog box.
Paste Special

Fixed the Remove Unused Files option to remove the texture files associated with the
deleted palettes.

Sound

Fixed an issue where sound was not present in the QuickTime movie. This happened
when the sound volume was modified in the Sound Editor.

Miscellaneous

Fixed an issue where textures did not appear in Collada files coming from SketchUp.

Toon Boom Harmony 12.1.1 Release Notes
Version 12.1.1

Here are the new features, changes, improvements, and bug fixes in Toon Boom Harmony 12.1.1:
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Features
Feature

Description

Scripting

A new scripting API was implemented. It is used in the copy/paste : setPasteSpecialFullTransfer( bool ). This lets you decide if you want to, for example, copy local parameter values when pasting a template in a scene.

Rendering progress messages

Improved rendering progress messages in the logs now indicates when all activity to
render a frame is finished.

Extracting skew information

Added ability to extract skew information from 2D matrices in scripting environment.

What's Fixed?
Item Fixed

Description

Fixed crash

Fixed crashes when the Convert to New Drawing and Add Deformation Chain command was used on one of multiple layer's children to a deformation group.
A fix was implemented to hide anonymous (ATV-xxxx) columns on the left side of the
Xsheet view.
Fixed an issue when deformed bitmap images appeared as white rectangles when
reopening a scene.

Fixed issues

Fixed an issue related to the blending modes and the glow filter. When overlapping
these two filters, some holes were appearing in the render. For the ChannelFix plugin,
contact Toon Boom Support.
Fixed the Convert Deformed Drawing to Drawing menu command. When multiple drawing nodes were under the same Transformation Switch, it did not work.
Removed the minimum length of the resting position handles of Curve deformers. It was
preventing the creation of smooth curves on very small drawings.

Miscellaneous

Reoptimized the playback of scenes with deformations.

Toon Boom Harmony 12.1 Release Notes
Version 12.1

Here are the new features, changes, improvements, and bug fixes in Toon Boom Harmony 12.1:
•

Features on page 6

•

Changes and Improvements on page 9

•

What's Fixed? on page 9

Features
Feature

Description

Deformation

Create New Deformation Chain Tool
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A new tool called Create New Deformation Chain lets you create new chains of
deformers for new drawings by adding a Transformation-Switch node to your
deformations. You can find this new tool in the Deformation toolbar.
Transformation-Switch Node
A new Transformation-Switch node lets you connect chains of deformations, Pegs,
Mesh Warp, Quadmap, Quake or Ortholock nodes. The timing of drawings in a layer
determines which chain is used.
Converter Script
A converter script called TB_ConvertLegacyDeformation.js changes old deformation
chains into the new Harmony 12 style.
Deformation Toolbar
•

A new button called Enable Deformations lets you show deformed state of all
deformed chains while drawing. It's a bit like the Set Up button in previous
versions. Enabling this button shows the onion skins and other layers with
images deformed or not.

•

The Reset Current Keyframe button lets you copy the set up position as
keyframe values at the current frame (like the Copy resting position to Current in
Harmony 11).

•

The Transformation Selector lets you easily change the deformation chain
associated with specific drawings. When using this, it changes the associated
drawing in the Transformation Switch.

(Harmony Premium)

Convert to New Drawing and Add Deformation Chain
This feature creates a new drawing from the deformed current drawing and then
associates it to a new deformation chain that has all the same deformer nodes as the
original chain. It copies the values of the current keyframes and pastes them as the
initial values of the new chain.
Rename Transformation
Allows you to give a more informative name to your transformation chains, either your
deformation chains or any other type of chains made of peg, Mesh-warp, etc.

Web Control Center

The Web Control Center lets you perform most of the operations that the Control Center
does but through a web browser. You can create, delete environments, jobs, scenes
and users, as well as export from and import to the database from another site or onsite.
There are movie and thumbnail previews of scenes, and you can send scenes to render.
Remove Duplicate Key Exposure

Timeline

There is a new button in the Timeline toolbar for removing unnecessary drawing key
exposures that were created when pasting with the Enforce Key Exposure option
selected (for example).
Enforce Key Exposure

Timeline
(Harmony Premium & Advanced)

A new paste option lets you decide whether to create key exposures or not. This option
is located in two places:
•

Timeline view menu (Edit > Modify Paste Presets)

•

Paste Special dialog box
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Paste Mode for Pasting Keyframe and Exposure Values
You can change the way the normal paste works. There were two presets; one for
keyframes and one for exposure. Now there is a third one for pasting both keyframe and
drawing exposure values at the same time. Also, you can customize the three presets
to your liking.
Tip: You can also use these three presets as a quick way to change how the paste
works if you don’t want to limit them to keyframes or exposures.
All three presets are available from the Timeline view menu (Edit > Modify Paste
Presets).
Extend Timing and Swap Drawings
Two new options allow you to extend the timing and swap drawings when dragging,
copying, cutting or pasting in the Timeline and Xsheet views. The Fill Gap with Previous
Drawing option is used at the source of the cut and the Fill to Next Key Exposure is
used at the destination of the paste.
These options are located in two places:
•

Timeline view menu (Edit > Modify Paste Presets)

•

Paste Special dialog box—see Using Paste Special on page 1.

Extend Exposure of Previous Drawing
When this option is selected, drawing something in a blank frame will create a new
drawing and extend the timing from the previous exposed drawing (like in older versions
of Harmony).
This option is called Extend Exposure of Previous Drawing and is located in the
Preferences dialog box:
Harmony Essentials: General tab, Timeline section.
Preferences

Harmony Advanced and Premium: Exposure Sheet tab, Drawing Creation section.
(Harmony Advanced and Premium) Overriding Exposure and Keyframe During
Drag and Drop
A new option lets you overwrite exposure and keyframes while dragging and dropping.
This option is located in two places:

Drawing
(Harmony Premium & Advanced)

Customer Experience Improvement Program

•

Timeline toolbar, Toggle Override Exposure and Keyframe During Drag and Drop
button

•

Preferences, Timeline tab

Using bitmap brushes with a complex set of properties has been optimized to be two to
three times faster!
Harmony now includes the optional Customer Experience Improvement Program
whereby usage information is collected and sent to Toon Boom. The data does not
contain any personally identifiable information and cannot be used to identify you. The
data will consist of a basic hardware description, a project summary and usage
information. We will only use this information for software improvement purposes, as
well as sharing the information with third parties for the same reason.
The Customer Experience Improvement Program is enabled by default but is voluntary.
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If you prefer not to participate, you can opt out when you first launch the software, by
using a global preference, or by a command line argument.

Changes and Improvements
Changes and Improvements

Description

Deformation
The Deformation tool properties retain their state when you restart the application.
(Harmony Premium)
Updated Dictionaries with Web Control Center
Web Control Center

You must update the comp.dict file in the database so Web Control Center works
properly. It is now possible for the path to be longer when sending a scene to batch
render (Harmony Premium and Advanced).

Preferences

Added number of undos in preferences for Harmony Advanced and Essentials.

Nodes

Insert a node into the Node view automatically by pressing Enter while you have a node
selected in the Node Library view.
•

The Export to Harmony.zxp extension for exporting files to Harmony from Flash
is now included with Harmony. You no longer need to request the extension from
us. For the locations of the extension, see .

•

When importing SWF files, you can import files that have a compression of
Photo (JPG) or Lossless (PNG).

Flash Import
(Harmony Premium & Advanced)

What's Fixed?
Item Fixed

Description

Fixed crash

When using Colour-Override while keeping the softrender active and adjusting the Colour-Override values.
When importing a SWF file with faulty tag for JPEG image.
The picker from the Colour Picker window works differently to support picking outside
the application. To pick a colour, hold down the mouse button as you move along the
desktop to preview colours, then release to select the colour.
If the Sticky Eye Dropper option in the Preferences dialog box (Drawing tab > Options
section) is selected, the dropper will not have this new behaviour.
Parts of a drawing were not showing in OpenGL preview.

Fixed issues

The trial version of Harmony Essentials did not see the drawings just created.
The Onion Skins of new Bones and Game Bones unintentionally change as you edit the
bones.
Four-digit numbers don’t fit in the Frames, Start and Stop fields of the Playback toolbar.
The Blur-Radial-Zoom from Harmony 10.3.1.9206 gave a different result in Harmony 12.
The pencil lines of drawings do not retain their size after copy/pasting them into a new
drawing layer.

9

Toon Boom Harmony 12.0 Release Notes

Duplicating a drawing removes all the key exposures of the current drawing.
When the Onion Skin is set to Outline Only, it didn't work on drawings with deformers.
A template that includes a deformation has a thumbnail generated that does not include
the bounding box of the deformed drawing. This results in the thumbnail showing only
the other undeformed drawings.
The render of small pencil lines did not produce nice curves but rather angular results.
The palette-list was not saved in a new scene if you did a Save As New Version instead
of Save.
Fixed export of deformation to SWF.
Fixed wrong compositing order with legacy scenes with symbols.
Fixed cel swapping from the Library view when you have symbols.
Fixed unreadable palette and scene when a colour swatch name contains a backslash
(\).
Fixed wrongly displaying the internal peg controls of a drawing layer when displaying the
deformation controls.
Fixed import of AI file with name of 43 characters.
Fixed texture shifts on mouse up when using the vector brush tool.
Miscellaneous

Fixed the somewhat random order of cables when dropping a parent between two children in the Timeline view.
Fixed incorrect behaviour of Toon Boom bitmap image when using the Colour-Override
nodes. They were blocked when using Render Selected Colours or Render Selected
Colours and Bitmaps.
Fixed animated Collada files that do not import properly.
Fixed disappearing drawings in scene with symbols converted from Animate 3.
Fixed Show Strokes option that didn't show them in Line Art in Camera view OpenGL.
Fixed wrong directory path when importing a scene with Control Center from a shell command.
Fixed Vectorization dialog box: strictness and pegSide or fieldChart settings.

Toon Boom Harmony 12 Release Notes
Release 12

Here are the new features, changes, and improvements in Toon Boom Harmony 12:
•

The New Harmony on page 11

•

Drawing Tools on page 12

•

Animation Tools on page 12

•

Compositing and Effects on page 13

•

Import on page 16

•

Timeline on page 17

•

Miscellaneous on page 18
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The New Harmony
Three Editions

Toon Boom Harmony is now available in three editions, catering to different types of users and their unique animation
requirements:
•

Harmony Essentials is for simple paperless and cut-out style animation projects. By using the introductory edition
of Harmony, enthusiasts and hobbyists have all the fundamental drawing, painting and animation tools they need.

•

Harmony Advanced is a professional-grade solution for studios, freelancers or anyone who needs full paperless
and simple cut-out animation capabilities.

•

Harmony Premium is for full paperless and sophisticated cut-out style animation. This is the most powerful,
professional edition of Harmony that adds the ability to create sophisticated character rigs, highly organic movement
and unlimited special effects for any style of animation.

Desktop Subscription
Harmony is now available by Desktop subscription, which lets you choose the level at which you want to use Harmony and its
features. You can subscribe monthly or annually—visit Desktop Subscription.

Online Availability
Harmony 12.1 is available for purchase at the Toon Boom online store. A full-featured Trial version for each Harmony edition is
also available. Harmony can be updated online via the Toon Boom Upgrade Center.
For more information, visit the following:
•

Toon Boom Store

•

Trial Versions of Harmony

•

Toon Boom Upgrade Center

Harmony Server

Production Efficiency
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Harmony Server (formerly called Network) enables production teams working in Harmony Advanced and Harmony Premium to
access shared assets directly from a database in a server-client configuration. The server stores all the assets and holds the
database. Clients machines run Harmony and access the database instead of storing files locally. You can share assets,
vectorize and render in batch for increased productivity and security.

Drawing Tools

Bitmap/Vector Drawing and Bitmap Brush Engine

Bitmap Brush Improvements
The brush engine in Harmony has been improved to provide even better quality and more artistic control. You can now control
the brush shape to provide a random effect on strokes or create and save a custom brush that acts like a calligraphy pen fixed
at any angle you desire.
A dual tip is introduced that mixes two shapes or textures cookie cutter style to create an infinite range of fuzzy or watercolour
lines. This is perfect for organic and experimental drawing styles. Previously, you were limited to a finite number of brush
presets.

Update Brush Properties
You can select a preset brush, pencil or eraser and change its properties to update the preset instead of creating a new one.

Animation Tools

Deformers and Game Engine Export

Game Bone Deformers
A simplified set of Game Bone deformers is provided for easy import into game engines like Unity. The properties of these
bones can be read by game engines and are optimized for real-time deformations in a game.

12

Toon Boom Harmony 12.0 Release Notes

Simpler Bone Set-up (Workflow)
The default user interface for creating bones in Harmony is now more straightforward in operation and simpler to understand.
Set-up is now a single operation, instead of requiring two different tools and one mode. This provides for additional efficiency
and clarity throughout the process.

Envelope Deformers
You can now apply an overall bend or stretch to a set of deformers for even more flexibility. The new Envelope option for Curve
and Offset deformers lets you generate and distort an envelope around an object and deform it while keeping its parent or child
curves intact. It could be used, for example, to squeeze the overall shape of an octopus character to fit through a porthole
without affecting the curves used to manipulate each tentacle.

Harmony Game Previewer
The new Harmony Previewer lets you see if your animations and rigs will work once imported in Unity. This can be useful if
you're not a developer. You can visualize your characters in the Unity game engine with no programming required. To get the
latest version of the Harmony Game Previewer, visit toonboom.com/games.

Compositing and Effects

Node-based Compositing

Terminology
The term "module" has been replaced with "node". Module Library is called Node Library and Network view is called Node
view.

Node (Module) Library Search
The ability to search nodes has been introduced in order to provide a quick way to find your effects, like Bloom, Burn-In
Luminance, Blurs, Colour Override, Particles or Lens Flare. We also added more descriptions to provide better search results.
The search will not only look through the node names, but also the descriptions. For example, when you type the letters for
“blur”, you will gets search results for Blur-Box and Shadow (the word blur is in the description for the Shadow node).

Node Library Organization Improvement
A new vertical listing of node names allows you to more rapidly find the effects you want to use in the compositing process.
This interface improvement allows an unlimited number of nodes to be presented along with their subgroups.
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Node Backdrops
Backdrops are a way to work with complex node systems that let you associate a selected set of nodes by colour. You can
add as many backdrops to your node structure as needed. The idea is to visually organize the structure so you can quickly
identify the particular set of nodes.

Node Properties
Nodes have collapsible parameters sections to take less room.

Node Connections
When connecting to a node, you can now see input ports that reveal what type of connection is supported by each port.

Node Port Tooltips
A tooltip appears when you hover over node ports. The parent/child node is displayed, as well as the type of input or output port
you are using.

Insert Menu
The new Insert menu, which you can access from the top menu, allows you to quickly add any effect from a menu list instead
of dragging them from the Node library. This can be useful in speeding up your workflow.

Support for OpenFX Plugins

OpenFX
With Harmony 12.1, you can add third party OpenFX plugins into the Node Library to have an expanded range of effects to use
in compositing operations. This not only expands the range of effects that can be applied to a production, it also consolidates
workflow within Harmony by avoiding a back and forth workflow with an external compositor. You can obtain OpenFX plugins
from open source providers or commercial OpenFX plugin creators such as GenArts Inc..

Burn-In Node
A new node (module) called Burn-In lets you superimpose scene information, which is visible in the Camera view. The
information is displayed on top of any content in the scene. You can choose to display the scene name, timecode, frame count,
environment and job, as well as add a frame offset if you need blank frames to precede the scene content. Also, to make the
information more visible, you can also add a background and choose its colour, and customize the text font and alignment.
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Light Shading Node

Light Shading
Cut-out animation allows for great advancements and time saving in production. However, it's not easy to create tone and
highlights. To do so, you must draw all the highlight zones for each frame by hand. Following that, if you want to modify your
animation, you have to redraw those zones. This slows down the process. There are a few tricks for doing simple automated
highlights, but the results are not always convincing.
The Light Shading node provides a proper solution to this issue. It allows you to add a few nodes to your original puppet rig and
obtain a customizable lighting effect on your characters. It can be applied to any object in your scene, not only on cut-out
characters. The light shading effect allows you to define your volume zones and generate a normal map, as well as your light
source and animate its position.

Median Node
A new node (module) called Median lets you smooth out imperfections in your drawings and deliver a posterization effect with a
slight blur. Harmony sorts the values of pixels within a specified radius and uses the median value. It can be used to add
glamour to a character’s face or create an Impressionistic style to a background.

Render Preview Node
A new node lets you more quickly preview effects on your screen when using OpenGL, so you can more easily test animated
effects on screen. It provides a variable quality preview of an effect, removing the need to render out to an intermediate file(s).
This is especially useful for evaluating OpenFX plugins when you want to see the visual impact of changing individual
parameters.

Bloom Node
A new node (module) called Bloom lets you isolate bright areas and achieve a nice atmospheric effect which is useful for foggy
streetlights or glowing faces in front of a flickering fireplace. It's also especially good for adding a bloom to once hard-to-isolate
areas, such as on an imported photo of a night time street. The Bloom effect is a combination of the Luminance Threshold,
Cutter, Blur - Gaussian and Composite Generic nodes.

Luminance-Threshold Node
The new Luminance-Threshold node allows you to isolate areas of an image according to their brightness, and subsequently
apply effects to those regions. You can add a ghostlike glow effect to all the shiny armour in a scene for example.

Placeholder Node
The Placeholder has been removed from the Node Library.
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Constant Particle Generation Option

Particle System
You can now have Harmony optionally generate particles between frames to create things like constant comet trail effect. This
new particle emitter option provides for particle system continuity over the life of the particle system. You can use it to create
jet exhausts, volcanic eruptions, or sparkler effects that need to span a range of frames.

Exposure Fill Using Render Change Option
Harmony can now detect if a threshold of changes has occurred between two consecutive images and then expose the
affected textures for further processing. It can be used for example to change the texture on a characters shirt only when the
shape of the shirt is changed significantly from the previous frame. This avoids unnecessary repetitive texture changes on
every frame.

Intensity Option
This new Intensity option lets you directly vary the intensity of Glow, Matte-Blur, Shadow, Highlight and Tone effects. This
means you don’t have double or triple the connection to make the effect stronger.

Colour Override Options
Two Colour Override options give you more flexibility in changing individual colours when you have a network of nodes that
includes a matte. It lets you decide if you want to apply the Colour Override to only to the image, or also to the matte, of the
parent effects.

Flatten Option
When using the Line Art or Overlay Layer node and placing a node below a Composite node containing several drawing nodes,
such as a cut-out character, you can use the new Flatten option to flatten the extracted result. For example, when extracting a
series of outlines, parts that may have been hidden by colour fills might now be visible. The Flatten option cuts the extra
artwork.

Import
Importing FLA Files
You can import and export files from Flash to Harmony to transfer character rigs, props and backgrounds. Flash import is
available on all three editions of Harmony on Windows and Mac OS X. It is not possible to do so on Linux versions.
On the Flash side, the command works on these versions: Adobe Flash CS5 to Adobe Flash CC. Exports from older versions
of Flash software is not possible.
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New 3D Import Formats
Harmony can now import new 3D formats as 3D elements in your project. The new formats are two popular data exchange
formats: Collada (.dae) and Alembic (.abc).

OSB Conversion Option
There is a new option to convert 3D files directly to the OSB file format and save them so the next time you reload the scene, it
is quicker as Harmony does not have to reconvert them again. This improves workflow in situations where multiple 3D files
(with their own relative paths) were loaded by storing them in a single file.

More Powerful SWF Import
There is now support for a later version of the SWF (SWF 10) format, avoiding the need to use older versions of Flash to export
files to Harmony.

Vectorization Parameters Dialog Box
The Vectorization Parameters dialog box has been reorganized for efficiency.

Timeline
Solo Mode
Using the new Solo mode, you can temporarily display one or multiple layers in the Camera view without changing the final
output. You can also activate/deactivate selected layers without redoing the selection for additional display control.

Show/Hide Additional Links
The new Show/Hide Additional Links
button at the bottom-left of the Timeline view lets you display links associated with a
layer. For example, if you connect a mask to more than one effect such as a Tone and a Highlight, you can see these
connections in the Additional Links section, as well as links to composite nodes.

Connect Multi-layers as Input to Effects
You now have the ability to connect multi-layers as input to effects.

Apply Ease on the Timeline View
The new Set Ease Menu in the Timeline toolbar lets you quickly and easily create different speed patterns between keyframes.
You can customize the Timeline toolbar with the corresponding toolbar button called Apply Ease to Selection
. This lets you
quickly reapply the ease type without going through the Set Ease Type menu each time.

Shortcut for Scene Markers
There is a new shortcut for scene markers called Mark Current Frame.
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Parameters Section
In the Timeline view, the Parameters section uses alternating colours to differentiate the area from the layers.

Groups in the Timeline View
Groups in the Timeline view are now easier to identify with the new icons expanding groups, which also show child layers in the
timeline.

Paste Special Option
A new Paste Special option, called Replace Existing Drawings, replaces drawings with the same names to update a scene
with new modified drawings and preserve the animation. This lets you modify rigs or animations non-destructively by only
replacing the drawings. You could easily replace or update the shirt on an animated character, for example. You can find this
option in the Advanced tab of the Paste Special dialog box.

Miscellaneous
More Useful Tooltips
Tooltips now contain more information about tools, tool properties, and scripts.

Search for Shortcuts
You can easily find shortcuts with a new search capability in the Preferences dialog box.

Script Icon Tooltips
You can now reveal the function of a script by viewing its tooltips, which you provide.

Overwrite Images During Scan
In Harmony Advanced and Harmony Premium, you can overwrite existing images but keep the same cell names. This allows
you to fill your exposure first and then fill it with the scanned images.

Web Control Center (Part of Harmony Server)
A new web interface for the Web Control Center offers the ability for Harmony users working from remote locations to upload
and download projects to a central server using the Internet.
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